
TERMS OF AGREEMENT

This is a legal agreement between you, the users, and kwakkelflap.com.
By installing or using this Software, you agree to be bound by the terms of this agreement. If you do not agree to those terms, you may
not use or install the Software.

You may use one copy of the Software on only one computer at a time. If you have multiple licenses of the Software, you may use as
many copies at any time as you have a license. "Use" means loaded in temporary memory or permanent storage on the computer.
Installation on a network server solely for distribution to other computers is not "use", if you have a separate license for each computer
to which the Software is distributed. If the number of users will exceed the number of licenses, you must have a reasonable process to
assure that the number of persons using the Software concurrently does not exceed the number of licenses.

The Software is protected by Belgian and United States copyright laws and international treaties. You may make one copy of the
Software solely for backup or archival purposes or transfer it to a single hard disk provided you keep the original disk solely for
backup or archival purposes. You may not rent or lease the Software or copy any written materials accompanying the Software, but
you may transfer the Software and all accompanying materials on a permanent basis, if you retain no copies and the recipient agrees to
the terms of this Agreement. Any transfer must include the most recent update and all prior versions.

All intellectual property rights such as but not limited to patents, trademarks, copyrights or trade secret rights related to the Software
are the property of and remains vested in kwakkelflap.com/its suppliers.

You shall not modify, translate, reverse engineer, decompile or disassemble the Software or any part thereof or otherwise attempt to
derive source code or create derivative works therefrom. You are not allowed to remove, alter or destroy any proprietary, trademark or
copyright markings or notices placed upon or contained with the Software.

Registration Codes may be used, stored or copied only by the person or organisation, which has licensed the Software, and solely for
the purpose of using the Software within the terms and conditions of this Agreement. No person or organisation is permitted to store or
copy a Registration Code for any other purpose without written agreement from kwakkelflap.com. The copyright of all Registration
Codes remains vested in kwakkelflap.com which reserves the right to withhold or withdraw authorisation of use of all Registration
Codes issued to a person or organisation if there is reasonable evidence to indicate that the person or organisation is involved in a
breach of the terms of this document.

YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT USE OF THE SOFTWARE IS AT YOUR OWN RISK AND THAT
THE SOFTWARE IS PROVIDED "AS IS" WITHOUT ANY WARRANTIES OR CONDITIONS WHATSOEVER.
KWAKKELFLAP.COM OR ITS SUPPLIERS DOES NOT WARRANT THAT THE FUNCTIONS OF THE SOFTWARE WILL
MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR
FREE. YOU ASSUME RESPONSIBILITY FOR SELECTING THE SOFTWARE TO ACHIEVE YOUR INTENDED RESULTS,
AND FOR THE USE AND THE RESULTS OBTAINED FROM THE SOFTWARE.

YOU ACKNOWLEDGE THAT THE SOFTWARE IS NOT INTENDED FOR USE IN (I) ON-LINE CONTROL OF AIRCRAFT,
AIR TRAFFIC, AIRCRAFT NAVIGATION OR AIRCRAFT COMMUNICATIONS; OR (II) IN THE DESIGN, CONSTRUCTION,
OPERATION OR MAINTENANCE OF ANY NUCLEAR FACILITY.KWAKKELFLAP.COM AND ITS SUPPLIERS DISCLAIM
ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO WARRANTIES RELATED TO: NON-
INFRINGEMENT, ACCURACY OR COMPLETENESS OF RESPONSES OR RESULTS, IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE .

IN NO EVENT SHALL KWAKKELFLAP.COM OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, INCIDENTAL,
SPECIAL OR CONSEQUENTIAL DAMAGES OR FOR ANY DAMAGES WHATSOEVER (INCLUDING BUT NOT LIMITED
TO DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION,
PERSONAL INJURY, LOSS OF PRIVACY OR OTHER PECUNIARY OR OTHER LOSS WHATSOEVER) ARISING OUT OF
USE OR INABILITY TO USE THE SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
KWAKKELFLAP.COM ALSO DISCLAIMS ALL LIABILITY FOR ACTS OR MATERIAL PRESENTED BY THE
ADVERTISER, AD-SERVING PARTNERS OR OTHERS (INCLUDING UNAUTHORIZED USERS, OR "CRACKERS")

REGARDLESS OF THE FORM OF ACTION, KWAKKELFLAP.COM AND ITS SUPPLIERS AGGREGATE LIABILITY
ARISING OUT OF OR RELATED TO THIS AGREEMENT SHALL NOT EXCEED THE TOTAL AMOUNT PAYABLE BY
YOU UNDER THIS AGREEMENT.  THE FOREGOING LIMITATIONS, EXCLUSIONS AND DISCLAIMERS SHALL APPLY
TO THE MAXIMUM EXTENT ALLOWED BY APPLICABLE LAW.

The Software may be subject to export or import regulations, and the user agrees to comply strictly with all such laws and regulations.
The user agrees not to export or re-export the Software or any part thereof or information pertaining thereto to any country for which a
U.S. government agency requires an export license or other governmental approval without first obtaining such license or approval.

Notice to U.S. Government Users: The Software and any associated documentation are "Commercial Items," as that term is defined at
48 C.F.R. 2.101, consisting of "Commercial Computer Software" and "Commercial Computer Software Documentation," as such
terms are used in 48 C.F.R. 12.212 or 48 C.F.R. 227.7202, as applicable. Consistent with 48 C.F.R. 12.212 or 48 C.F.R. 227.7202-1
through 227.7202-4, as applicable, the Commercial Computer Software and Commercial Computer Software Documentation are
licensed to U.S. Government end users (a) only as Commercial Items and (b) with only those rights as are granted to all other end
users pursuant to the terms and conditions herein.



1. Introduction

Everyone hates program crashes. The fact is they happen frequently even in normal
environments. Wouldn't it be great to get rid of crashes, and keep programs running?

Watchdog - O - Matic is a software watchdog that monitors and diagnoses any program you
want. When the program being monitored encounters an error, Watchdog – O - Matic
automatically solves the problem and logs the error. If the monitored application crashes or
hangs, Watchdog - O - Matic will handle this and restart the application. Maximize uptime
and don't let your critical programs crash! Protect yourself with Watchdog – O - Matic.

Main features:

• No more embarrassing and expensive system outages
• Automatic crash handling and program recovery
• Know instantly when your server fails
• Monitor applications automatically when they are started
• Isolate the crash and keep your application running
• Detection of hanging (not responding) applications
• Self-check option: if a problem occurs that would stop the watchdog, then the computer
will reboot. Even if the watchdog fails, your software will be back running in no time (*)

• CPU average check: restart target if it's below or over the threshold (*)
• Memory check: restart the program if the memory usage is too big (*)
• Scheduler: start, stop, restart and watch your application automatically (*)



2. Installing

To install the Watchdog - O - Matic application, download the setup program using the link
you received. If the download has finished, start the setup program you just downloaded.
The setup wizard will guide you through various setup screens. When finished, the
application will be running.

Note: For NT/2000/XP/Vista users: you need administrator rights to run this setup utility.
Log in as a user with administrator rights before using this setup.

To uninstall the Watchdog - O - Matic application select Add/Remove programs from the
Windows Control Panel. Choose the Watchdog - O - Matic application in the list and click
the 'Add/Remove' button.

3. Configuring

The Watchdog - O - Matic application runs in the background. You can see a Tray Icon in
the system tray (it’s the yellow bug). You can right click the icon to get a menu. Or you can
double click the icon to show the Watchdog - O - Matic program.



3.1 Parts of the application

Tip: You can test the quality of certain software by looking at the First/Second /Hangs
exception numbers. High amounts of first chance exceptions generally means that the
applications makes mistakes, but the mistakes are corrected. This is not good and results in
an unstable program. Second chance exceptions are actual software crashes.

3.2 Testing Watchdog - O – Matic

To test the Watchdog - O - Matic program, you can do the following. Crash test application”
by selecting Start/Programs/Watchdog and clicking on the Crash icon. This is a test
application. In Watchdog – O – Matic, select 'Watch an active program' in the File menu (or
in the popup menu). A new dialog box will appear. Choose 'Crash.exe' in the dropdown list.
Don't bother with the other options for now. Click ok and you will see that the crash
program is added to the Watchdog - O - Matic list.



If you press the first button in the crash app, you will see the 'First' number in the
'First/Second Except.' increasing. This means the monitored program has made a first
chance exception, but handled the exception correctly. If you press the second button, the
crash app will crash. The second number in the Watchdog - O - Matic application will
increase and the test program will disappear for a few moments, and return. Without
Watchdog – O - Matic, the test application would have crashed and shown a message box.

Delete the running program by selecting it, and pressing the delete key or use the delete icon.
The test app will close itself down. If you want to see what would have happened without
the Watchdog - O - Matic application, run the test application a second time, but don’t
attach Watchdog – O – Matic. Test the buttons again. The first button will apparently do
nothing (although it creates an error the test application can handle). The second button will
make the program crash and you will see a very familiar message box.



3.3 Insert new items

To create a new watchdog, select ‘Create a new watchdog’ from the File menu (or the popup
menu). A dialog box will appear. Insert the process you want to monitor with the full path
name, or select browse to look for the file. You can select programs on your harddisk or on
your local network. Also, you can add any command line options you wish by putting them
in the separate box after the program.

By default, the ‘Watch this application automatically if it’s running’ option is enabled. This
means that when you run the selected application from anywhere, the Watchdog program
will always try to check it for errors. If you disable this option, the watchdog program will
only check your application if you start it from within the Watchdog – O – Matic application
manually. You can also select a process priority and CPU affinity. This should only be used if
you are certain of this as it can result in strange behaviour.

If all of this looks ok, you can select the 'Options' tab. Here, you can select how the
Watchdog - O - Matic program will react. Normally, the default settings will be ok, but you
can change them at wish.



• ‘Start with a x second delay’ will wait x seconds before the program will be started. Can
be useful if you want to delay the startup of certain programs

• 'Wait x s before restart' is by default enabled at 5 seconds. This gives the crashed
application an opportunity to clean things up when closing down before a new instance
of the program is started. This value can be increased for programs that need a lot of
cleaning-up. Disabling or decreasing this option will make the restart faster.

• ‘Restart if not responding for x minutes’. If selected, the Watchdog – O – Matic
application will check the target if it is still responding. If the target application hangs for
x minutes, it will be handled as a crash and restarted. This option is by default enabled at
2 minutes.

• ‘Prevent crash by suspending the offending thread’. Enable this option if you want to
keep the crashing application running by disabling the crashing code. Note that this is
generally not advisable. Default is disabled.

• The ‘Ignore return value’ will handle all program exits as suspicious behaviour and restart
the application. This means that the application will restart if a user closes it.

• ‘React on first chance exceptions' will make the Watchdog - O - Matic application very
sensitive when monitoring this process. It will restart the process on first chance
exceptions. You can test this setting on Olav. The test program will be restarted when
pressing the first button. Enabling this option is generally never needed.

• 'Don't react after crash (only log)' will not restart a crashed program. A crashed program
will stop running.



• ‘Reboot windows instead of restarting the application’: if this option is checked, each
time the watchdog would restart the application, it will reboot windows instead. This
enabled you to restart windows if a crash occurred.

The ‘pro options’ tab will enable you to set more advanced options.

• ‘Enable CPU average check’ will check the CPU usage of the application. It will calculate
the average for x minutes. If this value is between CPU min and CPU max, no action is
taken. If the average is below minimum or above maximum, the program will be
restarted.

• ‘Restart target if memory usage is above x KB’ will check the memory usage of your
application. If your program uses more than x KB, it will be restarted.

• ‘Run the following program on a crash’ enables you to run any program you want after a
crash is detected, before the program is restarted.



The schedule tab has al scheduling options.

Here, you can select when you want to watch the program if it is running, and when to
ignore the program (continuous evens). You can also start, stop and restart your program at
a certain time (triggered event). Simply select a certain time, then select the action you want
at that time.

Keep the “Watch if running” state to ignore the scheduling.



The email tab allows you to configure the email settings. Select the 'Mail error messages to
the following address' if you want Watchdog - O  - Matic to send an email if a program
crashed. This mail includes some crash information (why the program crashed, at what time,
...). The address you see is the 'Default To' you've configured in the general configuration.
When ‘Include register & disasm info’ is selected, some extensive debug info is also mailed
to you. You can send a test mail by pressing the 'Send a test mail' button. (note that you still
need to configure your mail options. This is explained a bit further in the manual.)

Here, you can see a sample email message (with register & disasm info) :

Watchdog - O - Matic Professional 5.00
App: Crash.exe (pid: 1636) First:1 Second:1 Hangs:0  CPU:0 Mem:0
Access Violation. The instruction at 0x6C3B8A9D ref erenced memory at
0x00000020. The memory could not be read.
The offending thread has been suspended.

Call Stack
SymInit: Symbol-SearchPath: '.;C:\WINNT', symOption s: 530, UserName:
'Administrator'
OS-Version: 5.0.2195 (Service Pack 4)
C:\Program Files\Kwakkelflap\Watchdog\Crash.exe:Cra sh.exe (00400000),
size: 57344 (result: 0), SymType: '-nosymbols-', PD B: 'C:\Program
Files\Kwakkelflap\Watchdog\Crash.exe', fileVersion:  1.0.0.2
C:\WINNT\system32\ntdll.dll:ntdll.dll (77F80000), s ize: 507904 (result:
0), SymType: '-exported-', PDB: 'C:\WINNT\system32\ ntdll.dll',
fileVersion: 5.0.2195.7006



C:\WINNT\system32\MFC42.DLL:MFC42.DLL (6C370000), s ize: 1028096 (result:
0), SymType: '-exported-', PDB: 'C:\WINNT\system32\ MFC42.DLL',
fileVersion: 6.0.9586.0
C:\WINNT\system32\VERSION.dll:VERSION.dll (77820000 ), size: 28672
(result: 0), SymType: '-exported-', PDB:
'C:\WINNT\system32\VERSION.dll', fileVersion: 5.0.2 195.6623
C:\WINNT\system32\SHELL32.dll:SHELL32.dll (7CF30000 ), size: 2379776
(result: 0), SymType: '-exported-', PDB:
'C:\WINNT\system32\SHELL32.dll', fileVersion: 5.0.3 900.7071
C:\WINNT\system32\SHLWAPI.dll:SHLWAPI.dll (70A70000 ), size: 417792
(result: 0), SymType: '-exported-', PDB:
'C:\WINNT\system32\SHLWAPI.dll', fileVersion: 6.0.2 800.1740
C:\WINNT\system32\MSVCR71.dll:MSVCR71.dll (7C340000 ), size: 352256
(result: 0), SymType: '-exported-', PDB:
'C:\WINNT\system32\MSVCR71.dll', fileVersion: 7.10. 3052.4
C:\Program Files\Browser MOUSE\MOUDL32A.DLL:MOUDL32 A.DLL (008F0000),
size: 61440 (result: 0), SymType: '-exported-', PDB : 'C:\Program
Files\Browser MOUSE\MOUDL32A.DLL', fileVersion: 3.0 .2.0
6C3B8A9D (MFC42): (filename not available): Ordinal 2463
780085BC (MSVCRT): (filename not available): endthr eadex
7C57B388 (KERNEL32): (filename not available): lstr cmpiW

State Dump
EAX:00B1FC50  EBX:000000C4  ECX:00000000  EDX:00405 69C  ESI:00000000
EDI:0012F934  EBP:00B1FF7C  ESP:00B1FF04  EIP:6C3B8 A9D  FLG:00000246
CS:001B   DS:0023  SS:0023  ES:0023   FS:0038  GS:0 000

6c3b8a9d 8b7e20           mov     edi,[esi+0x20]
6c3b8aa0 85ff             test    edi,edi
6c3b8aa2 7419             jz      +0x24 (6c3b8abd)
6c3b8aa4 6a00             push    0x0
6c3b8aa6 e802ffffff       call     (6c3b89ad)
6c3b8aab 85c0             test    eax,eax
6c3b8aad 740a             jz      +0x20 (6c3b8ab9)
6c3b8aaf ff7620           push    dword ptr [esi+0x 20]
6c3b8ab2 8bc8             mov     ecx,eax
6c3b8ab4 e8c0c8ffff       call     (6c3b5379)
6c3b8ab9 83662000         and     dword ptr [esi+0x 20],0x0
6c3b8abd 83663c00         and     dword ptr [esi+0x 3c],0x0
6c3b8ac1 8bc7             mov     eax,edi
6c3b8ac3 5f               pop     edi
6c3b8ac4 5e               pop     esi
6c3b8ac5 c3               ret
6c3b8ac6 c3               ret
6c3b8ac7 55               push    ebp
6c3b8ac8 8bec             mov     ebp,esp
6c3b8aca 817d0c60030000   cmp     dword ptr [ebp+0x c],0x360

System info:
Computer name: xxxxxxxxx

MD5 Checksum: D32F0A575B4FBFD0A3370ED104FB7B38

If all these settings are as you wish, press ok. The new watchdog will be created. You can
start the program from the Watchdog application if it’s not running already.



3.4 Monitor programs that are already running

If you've tested the Watchdog - O - Matic program with the test application as we've
explained above, then you have already tested this function. Select 'Watch an active program’
from the menu. A dialog box will appear. Select the process you want to monitor in the drop
down box. All options are similar as the ones explained above.

These items are not saved. They are temporary watchdog items and will exist as long as the
program is running.

3.5 Insert autorun items

Now that we've had our first encounter with the Watchdog - O - Matic application, we will
add some autorun items to Watchdog - O - Matic. Select the "Import Autostart Programs"
from the File menu. A dialog box will appear with all the applications that are started
automatically when Windows starts. You might want to check most of these applications,
cause these are the ones that run in the background all the time (for instance your mail
program).

Select all the applications you want to monitor with the Watchdog - O - Matic program.
Watchdog – O – Matic will automatically create new items for each of the autostart
programs you selected. These programs will be watched automatically.



3.6 Adjusting settings

To adjust the watchdog settings of a certain process, double click the item or choose
properties after right clicking the item. You will be able to adjust all the settings of the
watchdog.

3.7 Start/Stop monitoring applications

If you want the Watchdog - O - Matic application to stop monitoring an application, select
the application in the list. Right click on it and select ‘Suspend watching’. All new events are
no longer processed. This means the target can crash at will. Applications that are not
monitored have a greyed icon. If you want to continue the monitoring process, select
‘Resume watching’ from the same menu. You can also start, stop and restart your
application. Note that your application will disappear on a stop if you used the ‘Watch a
running program’ option.

3.8 Deleting items
To delete an item in the list (and thus stop monitoring the target application), select the item
and press the delete key, or use the ‘Delete watchdog’ button. Note that the target
application will be closed if it was running.



3.9 General configuration: Email settings

Change the email configuration if you want Watchdog - O - Matic to send emails when a
monitored program crash occurs. Select Options/Email Configuration to display the
configuration dialog. Fill in the SMTP Host and port and all other settings as needed. If
you’re not sure how to configure these items, ask your network administrator or look at the
settings of your email client and copy them.



3.10 Notifications

Apart from email, you can also get other notifications. You can enable these by going to
Options/Notifications.

The first notification is an MSN Messenger style message box that will be displayed if an
application crashes. The second option will play a selected sound if needed. Select your wave
file by browsing for it. You can always try the sound by pressing Play.

3.11 Adjusting default values

With this option, it is possible to adjust the default values. These are the values used when
you select to watch a new application / create a new item. Every time you choose to watch a
process, these values will be used by default. Of course, you can always adjust the values per
process you watch.



3.12 Shell integration: starting applications from explorer

With our shell integration system, you can start any application from explorer, or your start
menu. In explorer, select the application you want to start, and right click on the item. You’ll
see a new item in this menu.

If you select “Start with Watchdog – O - Matic”, our crash handling application will start the
selected program and check it with the default parameters. You can see the new program in
the regular Watchdog – O – Matic view, and you can change the check parameters. The
same option is available for items in the start menu. Note that this menu option is only
available when selecting an application that can be started.

3.13 Extra options professional edition

The professional edition of this software has some extra functions. Aside from a safer check
mechanism we have also added extra options. You can see them by selecting the Options ->
Extra Options Professional menu. You will see the following dialog.



The first option will reboot the system if a critical windows error occurred (also known as
Blue Screen of Death or BSOD). So the watchdog will even react on system faults it
normally can’t see. The second option allows you to enable/disable the task manager plugin.

The third option will start a self-checking mechanism. This means that the Watchdog – O –
Matic application will check itself. If a problem occurs that would halt the watchdog
functions (e.g. a crash, or hang) the computer will be rebooted. Even if the watchdog fails,
your software will be back running in no time.

The fourth option will reboot the computer every x hours. We included this option so you
would be able to start from a fresh windows boot every x hours. Even if watched programs
have memory leaks, or something else happens that clutters up windows, our watchdog is
able to start fresh. These functions have an extra force option. You should enable these
force options if you fear your machine will not reboot because of other hanging programs.

You probably don't want users to log in every time the watchdog has rebooted your system
due to a system failure or application crash. To solve this, you can use a program that will
automatically log on to the windows system. These programs are widely available on the net,
and most of them are free. You can also do the following procedures:

For NT:
http://support.microsoft.com/support/kb/articles/Q97/5/97.ASP

For 2000 / XP:
http://support.microsoft.com/support/kb/articles/Q310/5/84.ASP

3.14 Updating the software

If you want to update your version of Watchdog – O – Matic, simply select Update in the
about box. A connection to the internet will be made, and we will perform a version check.
If you have an older version, an update will be downloaded. Note that updating to a new
version will close Watchdog – O – Matic, and all the applications you are watching. Our
application will also inform you if no update is needed.

System requirements:
P75 or higher
Windows 95/98/Me/NT 4/2000/XP/2003 server/Vista
Internet Explorer 5.0 or better
8 MB free memory
VGA 256 colours

Information in this document and the software described herein is subject to change without
notice. Other products and companies referred to herein are trademarks or registered
trademarks of their respective companies or mark holders.


